Creating Posters with PowerPoint
Take a Class
The Galter Library teaches a related class called Creating Posters Using PowerPoint. See our Classes schedule for the
next available offering. If this class is not on our upcoming schedule, it is still available to you or your group by request.

Planning and Designing Your Poster
How much information is too much information? Do I have too many images on my poster? Too much text? Is the content
logically organized? Take a look at these helpful sites for some pointers when planning and designing your poster.
Note: Feinberg School of Medicine and Northwestern Medicine have a template available at the Office of Communications
Northwestern Box site. See the section on "inserting images" for the link.
Erren TC, Bourne PE (2007) Ten Simple Rules for a Good Poster Presentation. PLoS Comput Biol 3(5): e102.
doi:10.1371/journal.pcbi.0030102
Creating Effective Poster Presentations: An Effective Poster--from North Carolina State University
Designing Effective Posters--from University at Buffalo SUNY libraries
Scientific Poster Tutorial--from Makesigns.com
Creating Medical Poster Presentations--from Microsoft
Designing Conference Posters--Collin Purrington
Northwestern University CLIMB program's guide to creating posters. Great advice and guidance on good scientific
poster design!

Templates
The Northwestern University Feinberg School of Medicine Office of Communications has a Northwestern Box folder
with poster and slide templates (requires NU NetID login)
To find templates for posters online, try a Google search for "scientific poster templates". There are many good
templates available for free. One good choice is PosterPresentations.com, but there are many others.
Here's an example of a 3' x 5' poster (36" x 60") PowerPoint poster template from PosterPresentations.com. Note that it
has all of the font sizes set and all of the sections set for you. All you have to do is change the colors and add your own
text and images. Templates like these are a good place to start if you don't want to design your own poster.
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Getting Started
The following guide is for Microsoft Office 2007 and 2010. There is also a guide for creating posters with earlier versions of
PowerPoint.
Let's get started.
1. Open a presentation in PowerPoint
2. From the Layout pull-down menu choose Blank

3. Click on the Design ribbon, then choose Page Setup
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4. Under Slides sized for: select Custom
5. Set the width and height to the size you want. PowerPoint does not allow any dimension to be larger than 56", so if
your final poster is larger than 56" in either dimension, you may have to set the size in proportion to the final size
you want. For example, if you want a poster to be 3’x 6’, set the width to 36” and the height to 18”. When the poster
is printed, you will then print it at 200%.
6. Keep orientation of slide at Landscape unless you are composing a vertical poster.

Note: Be aware of the meeting requirements for the size of your poster. Conference planners often specify how big a
poster should be or how much space they can allocate to you. It's easiest if you establish your desired poster size prior to
adding text and graphics. It can be changed later, but it will most likely require you to readjust all your poster content.

Backgrounds and Color Schemes
You can easily change the background to include one or more colors. To create a slide with a single, solid background
color:
1.
2.
3.
4.
5.

Click on the Design ribbon
In the upper right-hand corner choose Format Background from the Background Styles pull-down button
Choose Solid Fill
From the paint can pull-down button, choose one of the Theme Colors, Standard Colors or More Colors
Close the Format Background dialog box
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To create a slide with a single gradient color or multiple colors:
1.
2.
3.
4.
5.
6.

Click on the Design ribbon
In the upper right-hand corner choose Format Background from the Background Styles pull-down button
Choose Gradient Fill
Click the Preset Colors pull-down button
Select one of the preset color schemes
If you are happy with the color scheme, click Apply to All

The colors of a gradient background are composed of stops. Each stop is a different color or different shade of the same
color. Notice that you can add more stops or delete stops. To change the color scheme:
1. Select the stop number that you want to change
2. From the paint can pull-down button, choose one of the Theme Colors, Standard Colors or More Colors
3. Repeat steps one and two to change the color of additional stops
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There are several fill types to choose from including Linear, Radial, Rectangular, and Path. Use the Type pull-down
menu to change the design of the slide.
The Linear fill type will display each stop as a line. Use the Direction pull-down button and Angle tool to modify this
fill type.
The Radial fill type will display the color stops as a series of circles or arcs depending on the direction you choose.
Tips:
It's okay to use colored backgrounds for a scientific poster--just make sure they are not distracting
If you use a white background, try using colored textboxes or headers for contrast and visual interest

Grid, Guides, and Ruler
You can display a grid, guides, and ruler to help with the placement of your poster elements.
1. Right-click on your blank slide and choose Ruler
2. Right-click on your blank slide and choose Grid and Guides
3. Check the following boxes:
Display grid on screen
Display drawing guides on screen
4. You should now see a grid and two moveable guides (one vertical, one horizontal) on your slide
5. To add a new guide, place your cursor on an existing guide, hold the Control key as you drag a new guide onto the
slide.
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Inserting Text
Use text boxes to organize your wording. To insert a text box:
1. From the Insert ribbon choose Text Box
2. Place your cursor on the slide, hold down the left mouse key, drag a text box onto the slide, and let go of the left
mouse key
3. Type text into the box
You may want to separate your headings/titles from the bulleted text by creating multiple text boxes for each element; this
makes formatting the text a little easier. The main thing is to determine the best size for your headings/titles and the
bulleted text, and to be consistent with your text boxes
Highlight the textbox border and use the arrow keys to move your textbox around. Use CTRL + arrow key to move a
textbox just a smidgeon.
Tips on text size and type: Text size can vary depending on the size and content of your poster.
Use "sans serif" (Helvetica, Arial) plain fonts for all text in the poster. It's easier to read from a distance.
Bold face is fine for title and headings, but not for the rest of the text.
Never use all caps--they are hard to read. Some experts recommend sentence case (not title case) for your title
Left align your text in all of the text boxes in the body of the poster
Title of the poster should be the largest text on the poster: at least 50-56 point size, but consider going up to 100
point
Names of authors: at least 30 point
Headers: at least 32-36 point
Bulleted text: at least 20-26 point
Body text no smaller than 12 point
Figure captions can be smaller (10 point)
Note: These font sizes reflect that in this example we are asking the printer to enlarge the entire poster by 200%. If
you are NOT enlarging your poster, double all the above sizes.There are no hard and fast rules; just keep in mind
the proportion of the elements in relation to each other.
Tips on text color:
Dark text on a light background is easier to read than light text on a dark background unless your font is large (like
the title)
Use no more than 3 colors of text

Inserting Images
You can insert any image onto your PowerPoint slide provided the image is saved on your hard drive, flash drive or shared
drive. To insert an image:
1. From the Insert ribbon choose Picture
2. Navigate to the file directly where the image is located, select the image file, and click Insert
You can then move the picture by dragging it or by selecting it, and using your arrow keys. Using the corner bullets to
resize the picture will guarantee that the height and width will change in proportion to each other. When you select an
image you will have a Format ribbon available to you which you can use to manipulate the image in dozens of ways.
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Note: You should ensure that your images are of sufficient quality to be printed. You should strive for resolution of 300 dpi
(dots per inch). Most web images are 72 dpi and when printed, will look blurry or jagged. Here are some general
guidelines:
At least 150 dpi, strive for 300 dpi - higher resolution is good, but can sometimes be grainy
Save photos as jpg or png; line art (graphs & simple shapes) is best as png only
It is best to scan your own images and save them in .jpg format. See this web site for further guidelines on graphics:
http://www.makesigns.com/tutorial/tutorial_graphics3.htm
The Northwestern University logo: Download the logo to insert in your poster at: Northwestern Brand Assets
The Feinberg School of Medicine logo: Download the Northwestern Medicine logo from the FSM Office of
Communications site
Tip: It's visually appealing to put a thin border of black or gray around your image for contrast and emphasis.

Inserting Lines, Drawings, Shapes, etc.
You can insert dozens of different shapes, lines, diagrams, and other graphical elements on to your poster. To do this,
start in the Insert ribbon and choose either Shapes or SmartArt to peruse the available options.

Inserting Charts and Tables
You can use the Insert function to insert an existing chart or create a new one, but it takes a few steps and can be
difficult.
There is a much easier way to insert a chart into a PowerPoint slide/poster. If you have created a chart using Excel, all of
the formatting functionality will work in PowerPoint.
1. Open Excel and select a chart you have created from your Excel data (click on the chart to select it)
2. Copy the chart
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3.
4.
5.
6.
7.

Go to your PowerPoint slide/poster
Paste the chart
Resize it as necessary to fit
Once a chart is inserted into PowerPoint, Chart Tools will become available from the menu ribbon
Click on any element in a chart and then use the Design, Layout and Format tabs to modify that element

Tips:
To better integrate your chart, you may wish to remove the graph lines and outline from the chart (unlike with
images)
Keep your chart data simple and easy to read
Use .png format for charts and graphs if you have to paste them as images into your poster. You will get better line
resolution.

Aligning and Grouping Poster Content
You can align different elements of your poster to each other, e.g. a textbox with another textbox, a textbox with an
image. To align elements:
1. Use your mouse to create a box around the elements to be aligned, or select each element while holding the
control key
2. Click the Format ribbon
3. From the Align pull-down menu choose Align Left, Align Center, Align Right, etc.
4. Make sure there is a check box next to Align Selected Objects

8 of 11

You can move a number of elements together, e.g. a textbox and a picture, by grouping them. To group multiple
elements:
1. Use your mouse to create a box around the elements to be grouped, or select each element while holding the
control key
2. Click the Arrange pull-down button
3. Click Group

Printing your Poster
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You can print a small proof of your poster by printing as you normally would. Just be sure to check Scale to fit paper in
the print dialog box. Otherwise only a portion of your poster will be printed.

Printing your Poster
Formatting for Print
Often colors in PowerPoint look very different on the screen than they do on paper. It is advisable to convert your poster
to a PDF file before submitting it to a printer.
You can print your poster any place you find a poster printer. Ask around other NU departments to see if you can use their
poster printer on a cost-recovery basis, i.e. cost of paper and ink.
Possibilities for the Northwestern community include:
Duplicating Services at NU (Quartet Digital Printing)
312/503-8995
Searle Building,RoomB-407 (basement)
Cell Imaging Facility
Be aware that you need to be trained by the CIF to print your poster there, and CIF poster printing is not a drop-off
service. Also, you must size your poster to the exact size to print at that facility (i.e. You cannot design your poster at halfscale). Other restrictions apply. Click the link above to see details about printing at CIF.

PosterPresentations.com--research poster printing. Online company that has templates, fast turnaround, several pricing
options and a special option for posters to be printed on fabric for easy folding and transport in your suitcase or carry-on.
http://www.makesigns.com/
http://www.megaprint.com/
http://www.printnorthstar.com/
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Printed: Tuesday, August 28, 2018 2:58 PM
Source: https://galter.northwestern.edu/help/creating-posters-with-powerpoint-windows.pdf
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